
EX-1LESSON 9 Building Charts

Concepts Review

True/False Questions
Each of the following statements is either true or false. Indicate your 
choice by circling T or F.

 1. A chart sheet includes the related worksheet data.

 2. A selected chart element displays selection handles and a bounding 
frame.

 3. The markers for a line chart can be formatted separately from the line.

 4. Excel determines the best type of chart for your data after you select it.

 5. Some chart layouts do not include a chart title.

 6. If you insert a new item in the range used in a chart, you add a data 
point.

 7. Each slice in a pie chart represents a data series.

 8. The chart style includes colors for the plot area as well as other chart 
elements.

Short Answer Questions
Write the correct answer in the space provided.

 1. What name describes a chart that appears on the worksheet with the 
data?

 2. What command tab includes the chart layout and style choices?

 3. What is the keyboard shortcut to create a chart sheet?

 4. If you have one data series with five data points, what type of chart 
might be best?

 5. What term describes a blend of colors for filling a bar or column?
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T    F 

T    F 

T    F 

T    F 

T    F 

T    F 

T    F 
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EX-2 UNIT 3 Enhancing Worksheet Appearance

 6. What can you use when two data series have drastically different 
values?

 7. What happens if you delete a data series used in a column chart from 
the worksheet?

 8. What is a data table?

Critical Thinking
Answer these questions on a separate page. There are no right or wrong 
answers. Support your answers with examples from your own experience, 
if possible.

 1. Discuss and determine what data and related charts might be developed 
for your school.

 2. What are some advantages of using charts over tabular data? What are 
some pitfalls of charts?

Skills Review

Exercise 9-26
View and print a chart.

 1. Open DecChart and save it as [your initials]9-26.

 2. View a chart by following these steps:

 a. Click the Page Layout tab.

 b.  Click the Selection Pane button . There are two objects on 
this sheet, a chart and a text box.

 c. Click Chart 4 in the Selection & Visibility pane.

  d.  Click Text Box 2. The bounding box and selection 
handles are visible; the box is beneath the chart.

  e.  At the bottom of the Selection & Visibility pane, click 
the Bring Forward button . The text box must 
be on top of the chart to be visible over the white 
background.

  f. Click cell A1. The chart is deselected.

REVIEW

The chart and text box numbers are not 
important.
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EX-3LESSON 9 Building Charts

 3. Print a chart object by following these steps:

 a. Close the Selection & Visibility pane.

 b.  Insert a header that includes the user name, but change it to your 
name.

 c.  Press �  and click OK. The worksheet and chart print on the 
same page.

 4. Prepare and submit your work. Save and close the workbook.

Exercise 9-27
Change the chart layout and style. Edit the chart title. Format axes. Add 
data labels.

 1.  Open NovReceipts and save it as [your initials]9-27. Change the Zoom 
size to 80% and adjust column widths if necessary.

 2. Change the chart layout and style by following these steps:

 a. Click the chart background to select the chart.

 b. Click the Chart Tools Design tab and change to Layout 1.

 c. Change to Style 45.

 3. Edit the chart title by following these steps:

  a. Click the chart title to select it.

  b.  Double-click November and key December in its 
place.

  c.  Point at the chart title to display a four-pointed 
arrow. Drag the title left to align with the state 
names.

  d.  Triple-click the title and point at the Mini toolbar. 
Click the Italic button .

 4.  Format an axis and delete the legend by following 
these steps:

  a.  Right-click any value on the horizontal axis. Choose 
Format Axis.

  b.  On the Axis Options pane, click the arrow for 
Display units. Choose Thousands and click Close. 
Excel automatically scales the values.

  c. Click Series 1 (the legend). Press .

 5. Add data labels by following these steps:

 a. Right-click any bar and choose Add data labels.

 b. Right-click one of the data labels. Choose Format Data Labels.

 c.  Click Number. Choose Currency with 0 decimals and $ as the Symbol. 
Click Close.

 6. Prepare and submit your worksheet. Save and close the workbook.

REVIEW

In editing mode, a double-click selects a 
word.

NOTE

The category axis (the state names) is 
vertical in this chart. The value axis is 

horizontal.
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Exercise 9-28
Create a chart object. Edit chart data and objects. Edit the data source.

 1. Create a new workbook and save it as [your initials]9-28.

 2.  In cell A1, key Sales of Waffle Cones. Make it 18-point 
Cambria.

 3.  In cell A2, key May 1. Fill dates to reach May 15 in cell 
A16.

 4. Key the following values in column B:

NOTE

Excel will assume the current year in the 
date.

Figure 9-22
01-May 1000

02-May 1200

03-May 1000

04-May 1500

05-May 1400

06-May 1000

07-May 1200

08-May 1000

09-May 1500

10-May 1400

11-May 1400

12-May 1500

13-May 1200

14-May 1000

15-May 800

 5. Create a chart object by following these steps:

 a.  Select cells A2:B16 and click the Insert tab. Click the Line button .

 b. Choose Line with markers in the second row.

 c.  On the Chart Tools Design tab, choose Layout 3 from the Chart 
Layouts gallery.

 d.  Point at the top edge of the chart to display a four-pointed arrow. 
Drag the chart so that its top-left corner aligns at cell A18.

 e.  Point at the bottom-right selection handle to display a two-pointed 
arrow. Drag the bottom-right selection handle to cell L32.

 f.  Click the Page Layout tab. Set landscape orientation.

 6. Edit data and objects by following these steps:

 a. Edit cell B5 to show 600 and cell B12 to show 800.

 b. Right-click the line and choose Format Data Series.

 c. On the Line Style pane in the Width box, set 3 pt.
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EX-5LESSON 9 Building Charts

 d.  Click Marker Options. In the Marker type group, choose Built-in. Set 
the marker Size to 10.

 e.  On the Marker Fill pane, choose Solid fill. Set the color to match the 
line.

  f.  On the Marker Line Color pane, use the same color 
as the line.

  g.  Click Shadow. Click the arrow for Presets and choose 
Offset Bottom in the Outer group. Click Close.

  h. Triple-click Chart Title and key Waffle Cone Sales.

  i. Click the “Series1” legend and press .

 7. Format the axes by following these steps:

 a.  Click the Chart Tools Layout tab. Click the Axis Titles button . 
Choose Primary Horizontal Axis Title and then Title Below Axis.

 b. Triple-click Axis Title and key May 1 through May 15.

 c.  Click the Axes button . Choose Primary Horizontal Axis and then 
Show Left to Right Axis.

 d.  Click the Gridlines button . Choose Primary Vertical Gridlines and 
then Major Gridlines.

 e. Click the chart background.

 f.  Click the Chart Tools Format tab. Verify that the chart area is the 
selected element.

 g.  In the Shape Styles group, click the More button .

 h.  Choose Subtle Effect – Dark 1.

 8. Edit the data source by following these steps:

 a.  Select the chart and press � . Click the Sheet2 tab and press 
� .

 b.  On Sheet1, insert a row at row 17. Key May 16 in cell A17 and 2000 in 
cell B17.

 c. Right-click the chart on Sheet2 and choose Select Data.

 d. Click cell A2 and drag to select cells A2:B17. Click OK.

 e.  Triple-click the horizontal axis title and change it to ...through May 16.

 f.  Click one of the dates to select them. On the Home tab, change the 
font to 9 point.

 9. Prepare and submit your work. Save and close the workbook.

Exercise 9-29
Create a combination chart. Use a gradient for a data series. Format a 
data series. Size a chart.

 1. Open ConeSales and save it as [your initials]9-29.

TIP

Click away from the chart to see your 
changes.
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EX-6 UNIT 3 Enhancing Worksheet Appearance

 2. Create a combination chart by following these steps:

 a. Click the Insert tab.

 b.  Select cells A3:C18 and click the Line button .

 c.  Choose Stacked line with markers (second icon, second row).

 d.  Click the Move Chart button . Choose New sheet and click OK.

 e.  Right-click the waffle cone line and choose Change Series Chart Type. 
Choose Area in the Area group and click OK.

 f.  Click the Chart Tools Layout tab. Click the Chart Title button . 
Choose Centered Overlay Title.

 g.  Triple-click Chart Title and key Waffle and Sugar Cone Sales.

 h.  Click the Gridlines button . Choose Primary Horizontal Gridlines and 
then Major and Minor Gridlines.

 3. Use a gradient for a series by following these steps:

  a.  Right-click in the area for the waffle cone series. 
Choose Format Data Series.

  b.  Click Fill and then Gradient fill. Click the arrow for 
Preset colors and choose Wheat.

   c.  Click the arrow for Direction and choose Linear Up.

   d. Click Close.

 4. Format a data series by following these steps:

 a. Right-click the sugar cone line and choose Format Data Series.

 b. Choose Line Color and Solid line. For the color, choose Black, Text 1.

 c. Choose Line Style. Set the Width to 3 pt.

 d. Choose Marker Options. Choose Built-in and set the size to 10.

 e. Choose Marker Fill and use the same color as the line.

 f. Choose Marker Line Color and set the same color. Click Close.

 5. Size a chart by following these steps:

 a.  Click the white chart background and click the Chart Tools Format 
tab.

 b. In the Size group, click in the Shape Height box and key 5.75.

 c. Set the shape width to 8.5.

 d.  Point at an edge of the chart to display a four-pointed arrow. Drag 
the chart so that it appears centered on the page.

 6.  Right-click Sheet1 and choose Hide. The data is hidden 
but is still used for the chart.

 7.  Prepare and submit your work. Save and close the 
workbook.

REVIEW

Preset gradients are preselected color 
blends.

TIP

You can right-click a sheet tab to unhide 
sheets.
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EX-7LESSON 9 Building Charts

Lesson Applications

Exercise 9-30
Create a scatter chart. Edit chart objects.

A scatter chart (a “scattergram”) does not have a category axis. Both axes 
show values. In the chart for this exercise, you show the relationship 
between a price decrease and increased sales.

 1. Open Scatter and save it as [your initials]9-30.

 2.  Select cells B6:C11 and create a scatter chart with 
straight lines and markers. Move the chart to its own 
sheet.

 3.  Apply Chart Layout 5 and Chart Style 38.

 4.  Choose a thickness for the line and a size/style for the 
markers. The line and markers should use Red Accent 2 
as the color.

 5.  Format the data labels so that there is no Y value included. Delete the 
legend.

 6.  Edit the chart title placeholder to Percentage Price Decrease and Increased 
Sales.

 7.  Edit the vertical axis title to Additional Sundaes Sold and make it 9-point 
Verdana. Edit the horizontal axis title to Promotional Price Decrease and 
make it 9-point.

 8.  Use 9-point for the numbers along each axis.

 9.  Prepare and submit your work.

Exercise 9-31
Create an exploded pie chart. Edit chart objects.

An exploded pie chart shows one or more of the slices detached from the 
rest of the pie to emphasize the slice(s). The Excel chart types show all the 
slices detached, but you can create your own chart with a single exploded 
slice.

NOTE

The worksheet uses the Aspect document 
theme.
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EX-8 UNIT 3 Enhancing Worksheet Appearance

 1. Open ExPie and save it as [your initials]9-31.

 2.  Create a 2-D pie chart below the data. Make the chart 
area as wide as the worksheet data borders. Align the 
top-left corner near cell A12 and the lower-right corner 
at about cell D35.

 3.  Use Chart Layout 5 and Chart Style 1. Key Shake Flavor 
Comparison as the chart title.

 4.  Format the data labels to use 9-point Calibri and place 
the labels in the center.

 5. Format the data series to set the angle of the first slice to 90.

 6.  Select the pie and then the Butterscotch slice. Drag the Butterscotch slice 
away from the pie, but not too far.

 7. Select the pie and format the data series with a solid black border.

 8.  Format the Vanilla slice as solid white. Format each of the other slices 
with a color, gradient, or texture that represents the flavor.

 9. Prepare and submit your work.

Exercise 9-32
Create and format a bubble chart.

The Klassy Kow Credit Union provides savings account records for 
employees who contribute regularly. You are to prepare a bubble chart to 
demonstrate why it is best to start saving as soon as possible. A bubble chart 
is similar to a scatter chart with an additional series.

 1. Open BubbleChart and save it as [your initials]9-32.

 2.  In column E, use the FV function to determine the 
value of an account with the interest rate shown. 
The original amount is the PV, the amount in the 
account when the savings program starts. Assume that 
payments are made at the beginning of the month.

 3.  Create a 3-D bubble chart using cells C6:E10. Place the chart below the 
data. Choose Layout 1 and Style 21.

 4.  As the chart title, key Growth of Your Deposits. Delete the legend.

 5.  Edit the horizontal axis title to Years in Program. Edit the vertical axis 
title to Monthly Savings.

 6.  Format the values for both axes appropriately.

 7.  Size the chart as needed. On the Chart Tools Format tab, choose a shape 
style.

 8.  Prepare and submit your work.

REVIEW

The four-pointed arrow is the move 
pointer; a two-pointed arrow is a sizing 

pointer.

REVIEW

Divide the interest rate by 12 for monthly 
payments.
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Exercise 9-33  Challenge Yourself
Edit chart data. Create and format a stock chart.

A stock chart plots daily stock price information. In the worksheet, the 
prices must be in this order from left to right: high price, low price, closing 
price. There are several variations for this chart type with some that include 
the open price and volume.

 1.  Open HighLow and unhide the Apr worksheet. Save the workbook as 
[your initials]9-33.

 2.  Review the April data and its chart. The close prices 
are correct. There are, however, other errors in the 
data. Review the data and edit it as needed.

 3.  There are errors in the May data. Find and correct 
them.

 4.  Create a stock chart for the May data using cells 
A4:D13. Move the chart to its own sheet. Use Chart 
Style 29. Delete the legend.

 5.  Format the vertical axis on the chart with a maximum value of 30 and a 
minimum value of 23.

 6.  Add a chart title and position it at the left. (Check the April chart.)

 7.  There are data points at the top and bottom tips of the vertical lines. 
Select each and format the markers so that they are visible.

 8. Prepare and submit your work.

NOTE

When preparing a stock chart, you should 
eliminate weekend and other nontrading 

days.

On Your Own
In these exercises you work on your own, as you would in a real-life work 
environment. Use the skills you’ve learned to accomplish the task—and be 
creative.

Exercise 9-34
In a new workbook, key your city, state, and ZIP code in cell A1. In cells 
A3:A12, enter the dates for the past ten days. Use a local newspaper or 
an Internet site to determine the high temperature for each of those days 
and key the values in column B. Create a line chart that plots the daily 
temperatures with a layout and style of your choice. Place the chart as a 
separate sheet. Save the workbook as [your initials]9-34. Prepare and submit 
your work.
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Exercise 9-35
Build a worksheet with a doughnut chart object to show your weekly 
expenses. Use at least six expense categories (food, gas, entertainment, 
books, etc.). Add a chart title and decide whether to show labels or 
percentages on the segments. Save the workbook as [your initials]9-35. 
Prepare and submit your work.

Exercise 9-36
Create a worksheet that lists first names of six friends in one column and 
their heights in inches in a second column. Create a column chart sheet 
with the names on the horizontal axis and heights on the vertical axis. Use 
a gradient or texture fill for the columns. Make other formatting choices so 
that your chart is easy to interpret. Hide the worksheet. Save the workbook 
as [your initials]9-36. Prepare and submit your work.
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